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Note for Mac users

Some keystrokes and menu items are different on a Mac from those used in Windows and Linux.
The table below gives some common substitutions for the instructions in this chapter. For a more
detailed list, see the application Help.

Windows or Linux Mac equivalent Effect

Tools > Options menu  LibreOffice > Preferences Access setup options
selection

Right-click Control+click Open a context menu

Ctrl (Control) 3 (Command) Used with other keys

F5 Shift+¥+F5 Open the Navigator

F11 #+T Open the Styles and Formatting window

Documentation for LibreOffice is available at http://www.libreoffice.org/get-help/documentation


http://www.libreoffice.org/get-help/documentation
mailto:documentation@global.libreoffice.org
http://creativecommons.org/licenses/by/3.0/
http://www.gnu.org/licenses/gpl.html

Contents

O 0T 0 3V 5 1o | 4L 2
(0] 111 01U (0] = 2
FROUDACK. . ..ot 2
F ol [0 1] [=Te o T 1= o | 2
Publication date and SOMWAIE VEISION. ... ....iei ittt e et e et e e e e et e e e e eenans 2

INOTE FOF MG LS OE S, tuuurenurrmurrmssrnnsrenssrmssrnsssasssansssssssnsssssssessssssssssssassssnsssssssssssansssnsssnsssnsssnnssen 2

General notes on the creation of a database.......cciciieciriiiircirsi e 4

New database using the internal HSQL engine.........cccooiininninnnnnnssssssssssssssssssssssssssssssnes 4

Accessing external databases..........cccii i ————————— 4
MYSQL QAtADASES. ... e a e e e e e 5
(0] 22T Sl F= L =1 o P oY ST PR 12
Y o] (=TT ] A CT= USSP 13
ThuNderbird AdArESS DOOK. .......veeee e ettt e ettt et e e et e e e e aens 14

Creating a Database 3



General notes on the creation of a database

The basics of creating a database in LibreOffice are described in Chapter 8 of the Getting Started
guide, Getting Started with Base.

The database component of LibreOffice, called Base, provides a graphical interface for working
with databases. In addition, LibreOffice contains a version of the HSQL database engine. This
HSQLDB database can only be used by a single user. The entire data set is stored in an ODB file
which has no file locking mechanism when opened by a user.

New database using the internal HSQL engine

If a database with multiple users is not planned, or the user wishes to gain some initial experience
with a database, the internal database engine will suffice. It is possible at some later stage to
transfer the database to an external HSQLDB environment, where multiple users can have
concurrent access to the database on the HSQLDB server. This is described in the Appendix to
this Handbook.

The creation of a new internal database is described in detail in Getting Started with Base.

A database which is registered in LibreOffice can be accessed by other program components as a
data source (for example, mail merge). This registration process can be carried out at a later stage
if desired.

Accessing external databases

An external database must exist before it can be accessed. Assuming that access to a database is
desired, the database must be set up to allow network connections with a specific user name and
password before external programs can connect to it.

When such a database is properly set up, a user may, depending on the available connection
software (the database driver), create tables, input data, and query data.

Click on File > New > Database to open the Database Wizard and allow a connection to an
existing database to be made. The list of available database types varies according to operating
system and user interface, but the following should always be available:

* dBase
e JDBC

e MySQL
e ODBC

* Oracle JDBC

* PostgreSQL

e Spreadsheet

e Text

e as well as various types of address books.

The connection options will vary according to the type of database selected. These can in any case
be corrected later, after the *.odb file is created.

Some database types (for example spreadsheets) do not allow new data to be entered. These are
used only to search for or report on existing data.
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MySQL databases

There was an extension for MySQL, the MySQL Native Connector, which should allow Base to
connect directly to a MySQL database. The extension was in the LibreOffice Extensions center
under the Base Category but is not being developed at present.

General access to MySQL for versions of LibreOffice from 3.5 onwads is via JDBC or ODBC. To be
able to use JDBC, it is necessary to install mysqgl-connector-java.jar. This Java Archive file is best
copied into the same folder where the current java version used in LibreOffice is located. This is
likely to be a subfolder like .. .javapath.../1lib/ext for a Linux installation.

Alternatively the appropriate folder containing the Java archive can be set through Tools >
Options > Java > ClassPath.

The method of access to an existing MySQL database is shown in the following steps.

0 Database Wizard ¥ X
Steps Welcome to the LibreOffice Database Wizard
1. 5elect databhase Ise the Database Wizard fo create a new database, open an existing database
. file, ar connectto a database stored on a server.
2. 5etup JOBC connection
3. 5et up user authentication
4 Save and proceed

What do you wantto do?

Create a new database
Qpen an existing database file
Recently used

Media_without_Macros

Open...

iConnectto an existing database!

JOEC

Help =< Back et == Einish zancel

Creation of a new database is only possible in the internal HSQLDB format. Connection to an
external database is only possible when the database already exists.

Select the Connect to an existing database option. A list of database formats is contained on the
pull-down menu. Select MySQL.
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® | Connectto an existing database

FIDBC v
JOBC
Oracle JOBC

__ KDE Address Book
'LDAF Address Book

___ SeaMonkey Address Book i

— — Thunderbird/lcedove Address Book —_—

Spreadsheet
dBASE
Text

ODBC H

PostgreSaL

Connection to MySQL can be via ODBC or JDBC unless a native MySQL connector has been
installed. In this case a direct connection to MySQL is possible.

In this example, select the Java connector JDBC.

03 Database Wizard v X
Steps Set up a connection to a MySQOL database
1. 5elect database You can connectto a MySQL database using either QDBEC or JOBC.

2. Set up MySQL connection Eéi?ﬁgscuntact your system administratar if you are unsure about the following
3. Setup JOBC connection

4. Setup user authentication

5. 5ave and proceed How do you want to connect to your MySQL database?
- Connectusing ODBC (Qpen Database Connectivity)
. Connect using JOBC (Java Database Connectivity);
- Connect directly
Help == Back et == Einish Zancel

S

The database name must be known and input.

If the MySQL server is on the same computer as LibreOffice, then the Server name can be set as
localhost. Otherwise the IP address of the server or its hostname on the network or internet must

be input. It is also possible to access a database with Base where the database is located on the
website of an Internet Service Provider.

The default port number will usually be correct.
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Type in the JDBC driver class and click the Test class button. A dialog should pop up confirming
that the connector is loaded and accessible using Java. The mysqgl-connector-java.jar file must

either be in the same path as the version of Java in use in LibreOffice or directly linked in to
LibreOffice.

0 - Database Wizard ~

I

Steps Set up connection to a MySQL database using JOBC

1. 5elect database Please enterthe required information to connectto a MySQL database using

2. Setup MySQL connection JDE_!C. [aote t_hat a JOBC driver class must be installed on your system and
registered with LibreOffice.

3. 5etup JOBC connection Flease contact your system administrator if you are unsure about the following
. settings.
4. Set up user authentication

5. Save and proceed

Datahase name |otest
Server localhost
Bort number 3306 Default: 3306

MySQL JDBC driver class:

com.mysql.jdbe. Driver Testclass
Help == Back Mext == Einish Zancel
5 & LibreOffice Base 2

6 The JOBEC driver was loaded successfully.
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Database Wizard

Steps Set up the user authentication

1. Select database
2. 5etup MySQL connection
3. Setup JOBC connection

4. Set up user authentication [EEEELEUELLE haseuser

5. 5ave and proceed

Some databases require you to enter a user name.

| Passwaord required:

Test Connection

Help == Back et == Einish Zancel

[

The database on the network should be protected with a user name and password. Again a
connection test may be carried out.

If a direct connection was selected, this test will generate error messages. Without

testing, Base will, at the end of the Assistant, open the database window and
connection to MySQL.

Note

0 Authentication Required Y@

Message from senver:
A password is needed to connect to the data source .

Enter user name and password for:

ser name
haseuser

Password

Aedrdririedr

Help Dk Zancel
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The connection test starts the authentication process using the user name previously input. After

the correct password is input, a dialog announces the result of the test. If MySQL is not running at
this time, an error message is shown.

e LibreOffice Base 2 &

6 Connection Test

The connection was established successfully.

Fl

The final step is registering the database. The database can, if necessary, be registered at a later
time to allow its use with Writer or Calc.

03 Database Wizard v &

Steps Decide how to proceed after saving the database

1. Select database
2. 85etup MySQL connection
3. 5etup JOBC connection

Do you want the wizard to register the database in LibreOffice?

¥es, registerthe database for me

s Mo, do not register the database!
4. Setup user authentication -

After the database file has been saved, what do you wantto do?
5. 5ave and proceed

v Openthe database for editing
N Create tables using the table wizard
Click 'Finish'to save the database.

Help =< Back Iext == Einish Cancel

]
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ihomelrobbyDokumente/Libre Office 08 109 €%

Title = Type Size Date modified

(] Andere_HBs Falder 3122012 09:51:37 e

(3 Anmerkungen_MNiedermair Folder 03.03.2013 20:4412

(7 Base_Erste_Schritte Folder 27122012, 213531

[(7 Base_Handbuch Folder 04042013 0918:33

[(7 Base_Handbuch_komplett Folder 13.03.2013, 2212:49

[(7 Base_HE_Englisch Folder 04042013 1218:37

(7 Base_HEB_LO_36 Folder 16.03.2013, 08:34:27 Y

1 Base HE LO 41 Folder 31.03.2013, 10:36:23 w

File name: Mew MySQL_JDBC Database vi| Save J

File type: 'ODF Datahase v | . Cancel |
| Help |

b Automatic file name extension

[ ]

The Assistant ends the connection process with the storage of the ODB database. The ODB
database contains all the connection information needed to allow tables in the database to be
accessed whenever the database is opened.

At this stage choose a hame for the ODB database file and save it. The next picture is a view of
the Base interface.

W/ New_MySQL_JDBC_Database.odb - LibreOffice Base @ o &
Eile Edit Wiew Inset Tools Window Help
B-r2d ce- NHE-0E2H
[5: Create Table in Design View... Description -
& Use Wizard to Create Table... Create a table by specifying the field
] names and properties, aswell asthe d...
Tables [ Create View...
Queries 9 None ~
T Name
2 Town
Forms
BRepons
MySQL (JDBEC) lotest haseuser localhost

[ ]

10 Creating a Database



The tables in the database are contained in the tree under the name of the database.

T
pB

The view of the table tree can be closed by clicking on the database name. For a single database
connection this does not make much sense, but it does give a visible indication of the direct
connection.

e MySQL_direkt_33.odb - LibreOffice Base ORI
File Edit View [nsert Tools Window Help b 4 |
BN 4  BENENERE==]
T
[] Create Table in Design View... | Description

| Use Wizard to Create Table. .

Tables [# Create View...
F—:I ;
R
Queries
- None -
(] Marme
Town
Fﬂrmﬁ I my5q|
F performance_schema
Eﬁ B test
Reports
MyS QL (Native) | test ' rabby | localhost

[

Instead of only the database input in Step 3 of the Wizard (see lower status bar), LibreOffice opens
all databases that are available in MySQL to the user “robby”.

Queries must include in the MySQL syntax not only the table hame but also the database which
contains, for example, the following code:

. FROM "myphplib"."ASB" AS "ASB", "myphplib"."Kategorien" AS "Kategorien"
It is also possible in every such case to specify an alias, made up from the database and table
names. More details are given in the chapter on Queries.

Tables can be created and deleted in a database. Fields with auto values may be created when
setting up the structure of tables. In MySQL the starting value of such fields defaults to 1.

Accessing external databases 11



dBase databases

dBase databases have a format where all data is contained in separate, previously initialized
tables. Links between the tables must be made in program code. Relations are not supported.

2. 5et up dBASE connection

3. 5ave and procee

N Database Wizard i &
Steps Set up a connection to dBASE files
1.5elect database Select the folder where the dBASE files are stored.

Eath to the dBASE files

' { Browse |

The connection is made to a specific folder. All DBF files in this folder will be included and shown in
the ODB database and can be linked together using queries.

Tables in dBase have no primary key. They can in principle be described as corresponding to the
worksheets in Calc.

. ket dBase.odb - LibreOffice Base &

G
C
¥ (%

File Edit View Insert Tools Window Help

3= RN N=NEN=RIE - Rl BN =l

Database

ET Create Tahle in Design View...
%] Use Wizard to Create Table...

r I

Description

ﬁ

_|
[[<%]
=T
o
I

'@ASB Mone -
= Ausleine
‘= Einband
‘= Erwerb
E Gesperrt
= Leihzaht
‘= Leihzahl
‘T Leihzeit
T Leser

‘5 Mahnung
FE Rueck_Nr
‘B Sprache
T Status
= Tage180
H Werkart

B

[io

ue

=
18]
[45]

ﬁ

ﬂ
=

=
wr

B m :
—
n

[

g

dBASE | ihomelrabbywDokumente/Programmierunglbibi_new/Biblio_DBE
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Tables can be created and will then be copied as new files in the folder previously selected.

The number of different field types for a new dBase table is clearly less than when the internal

HSQLDB format is used. In the following figure there are still some field types with the same type
name.

Field Name | Field Type |
ID Integer [INTEGER ]
Firsthlame Text [WARCHAR ]

[ |LastMame Text [VARCHAR] %

Yes/Mo [ BOOLEAN |
Memo [ LONGYARCHAR |
Decimal [ DECIMAL |
Decimal [ NUMERIC |
Integer [INTEGER ]
Double [DOUBLE ]
Double [ DOUBLE]

Text [ VARCHAR |

Date [ DATE | l

Date/Time [ TIMESTAMP ]

The dBase format is especially suitable for the exchange and extensive editing of data. In addition,
spreadsheet calculations can directly access dBase tables. It may be better to manipulate the data
in Base because Calc requires the input of the type of character encoding, whereas Base simply
takes the appropriate encoding provided by the operating system. Old dBase files may exhibit
small decoding errors where special characters have been used.

Spreadsheets

Calc or Excel spreadsheets can also be used as the table source for databases. If, however, a
Calc spreadsheet is used, no editing of the table data will be possible. If the Calc document is still
open, it will be write protected.

0 - Database Wizard v) (X
Steps Set up a connection to spreadsheets
1. 5elect database Click 'Browse...'to select a LibreOffice spreadsheet or Microsoft Excel workbook.

2. Setup Spreadsheet LibreOffice will open this file in read-only mode.
connection

- Location and file name
3. Save and proceed

Browse

BPasswaord required

The only questions to be answered are the location of the spreadsheet file and whether or not it is
password protected. Base then opens the spreadsheet and includes all worksheets in the

document. The first row is used for the field names and the worksheet names become the table
names.

Relationships between spreadsheets cannot be set up in Base, as Calc is not suitable for use as a
relational database.

Accessing external databases 13



Thunderbird address book

The Assistant will automatically seek a connection to an address book, for example as used in
Thunderbird. The assistant will prompt for the location of the ODB file that will be produced.

, &/ Thunderbird_Adressen.odb - LibreOffice Base @ @ @1
Eile Edit “iew Insert Tools Window Help b 4

BEBE e M E-0 B H

Create Table in Design View... | Description
e85  Use Wizard to Create Table...

Tables

=

Queries

= Collected Addresses Mone -
Jahrgang
Mathe_Jahrgang

‘F= Personal Address book

Forms

Eeports

Thunderbird/icedove Address Book | Thunderbird/icedove Address Book | | .

[

All tables are shown. As in Calc, the tables are not editable. Base uses the table data only for
gueries and mail merge applications.
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